Oracle OpenWorld 2008

Hands on Lab

Service Enable Oracle PeopleSoft with Oracle SOA Suite
BPEL Process Manager
# Table of Contents

1 LAB OVERVIEW.................................................................................................................................................. 3
2 GETTING STARTED ............................................................................................................................................. 4
   2.1 Starting SOA Suite ...................................................................................................................................... 4
3 CREATING THE BPEL PROCESS ..................................................................................................................... 5
   3.1 Creating the BPEL Workspace and Project ............................................................................................. 5
   3.2 Creating a Partner Link to Invoke the Component Interface Service ..................................................... 9
   3.3 Creating Invoke Activity .......................................................................................................................... 11
   3.4 Changing the Inbound Message Type ...................................................................................................... 15
   3.5 Changing the Outbound Message Type ................................................................................................... 18
   3.6 Creating an Assign to Copy Request Data to the PeopleSoft Web Service ........................................... 20
   3.7 Creating an Assign to Copy Response Data from the PeopleSoft Web Service ................................. 22
   3.8 Validating, Compiling and Deploying the BPEL Process ....................................................................... 24
4 TESTING THE INTEGRATION SOLUTION ......................................................................................................... 26
   4.1 Invoking the Component Interface Service from BPEL ........................................................................... 26
5 ADVANCED CREDIT ........................................................................................................................................... 30
   5.1 BPEL Console ........................................................................................................................................... 30
   5.2 JDeveloper ............................................................................................................................................... 30
   5.3 Log into PeopleSoft and lookup up PERSON_DATA CI ........................................................................... 30
1 Lab Overview

This lab demonstrates native Web services integration to PeopleSoft using Oracle BPEL Process Manager. There are two major mechanisms to integrate with PeopleSoft using Web services; one is using Component Interfaces (CI) and the other using Application Messaging. This lab focuses on Component Interfaces. Oracle BPEL Process Manager (and other products such as Enterprise Service Bus) can just as easily integrate with Application Messaging.

For more hands-on tutorials, check out the Oracle By Example Tutorials on the PeopleSoft and Fusion Middleware Best Practice Center on Oracle Technology Network:

http://www.oracle.com/technology/tech/fmw4apps/peoplesoft

In this Lab:

- You will use a WSDL generated from a Component Interface for PeopleSoft HR component PERSONAL_DATA
- The WSDL will be consumed by a BPEL Process
- A BPEL Process will invoke the Get() operation within the WSDL and pass in Emp #.
- The result will be a Sync response from PeopleSoft with Employee’s Personal Data

For the purpose of this lab, we have chosen not to secure the Component Interface (CI). However, in production environments, you would generally secure the CI, and the BPEL process would also then have to pass in and validate a userid and password combination.

The WSDL URL for PeopleSoft CI (PERSONAL_DATA) is pre-generated using the Provide Web Service Wizard in PIA (browser). The WSDL URL, which is an output of the wizard, is available for you to use for this lab. If you have time after your lab is complete, you may log into PeopleSoft to see how this was generated. There are instructions in the advanced credit section.

Software Used:

- PeopleSoft HCM 9.0 with PeopleTools 8.48
- Oracle SOA Suite version 10.1.3.1 [available for download from OTN]
- Oracle JDeveloper version 10.1.3.4 [available for download from OTN]

The PeopleSoft server is connected to the local lab environment using a wireless network.
2 Getting Started

2.1 Starting SOA Suite

Start Oracle SOA Suite using the StartBPEL shortcut in FMW4Apps → Shortcuts Folder on your desktop.

When it completes you will see a check mark like this:

Then start Oracle JDeveloper by clicking on the icon as below in the same folder.
3 Creating the BPEL Process

3.1 Creating the BPEL Workspace and Project

In the Applications – Navigator window, right-click on Applications and select New Application...

1. Name your Application TESTPSFT and accept all defaults (your Directory name may show up different than the figure below – ignore that and accept defaults). Click Ok button.
2. When the Create Project dialog appears, click on the Cancel button to dismiss it. We'll create the BPEL process another way.

3. Right-click the new TESTPSFT Applications, and then select New Project from the popup menu.
4. Select **BPEL on left and BPEL Process Project** from the list on the right pane and click **OK**. The BPEL Project Creation Wizard is then shown.

5. In the Project settings screen, set the Name of the process to **PersData** and make sure the Template used is **Synchronous BPEL Process**. Click on the **Finish** button.
6. You diagram should look like this.
7. Save your work by clicking on the Save All button in JDeveloper.

3.2 Creating a Partner Link to Invoke the Component Interface Service

1. In the Component Palette (upper right section of Jdeveloper window), select Services from the drop down menu.

2. Drag and drop a PartnerLink activity onto the right side of the designer window anywhere beneath the Services.
3. In the Create Partner Link window, enter the **PeopleSoft WSDL URL** in the **WSDL File** field and press the **ENTER** key. Oracle BPEL Process Manager will load WSDL from PeopleSoft repository.

The URL is:

```
http://hr848.us.oracle.com:7777/PSIGW/PeopleSoftServiceListeningConnector/
CI_CI_PERSONAL_DATA.1.wsdl
```

*Note: This is case sensitive.*
The **Name** and **Partner Link Type** fields will be automatically populated.

Select **CI_CI_PERSONAL_DATA_Provider** in the **Partner Role** field as shown below.

4. Click **OK**

3.3 Creating Invoke Activity

1. In the Component Palette section (upper right section of JDeveloper window), select **Process Activities** in the drop down list. The Process Activities display the BPEL activities that you can drag and drop into the process designer window.
2. Drag and drop an **Invoke** from the Component Palette section onto the canvas immediately **after** the **receiveInput** activity.

3. Double-click the **Invoke** icon to open the Invoke window

4. In the Invoke window, enter the following values.
   a. Set Invoke Name to **Invoke_PersDataCI**
   b. Click the flashlight icon for the Partner Link field to open the Partner Link Chooser popup window. Select Partner Link to **CI_CI_PERSONAL_DATA.1** and click **OK** button.
c. Set Operation to \texttt{CI\_CI\_PERSONAL\_DATA\_G}. This is the Get() operation within the CI.

\textbf{Note: When we exposed the CI from PeopleSoft, we only picked the Get() operation. The other CI operations (Find, Update, UpdateData and Create) were not exposed. If they were, you would have seen them all here in the drop down).}
Note: The response time will depend on your network connection as the WSDL definition is retrieved from the PeopleSoft server

d. Click on the ‘Auto-create variable’ icon next to the Input Variable text field to create a global variable for this activity. Accept defaults. Click Apply and then OK.

e. Click on the ‘Auto-create variable’ icon next to the Output Variable text field to create a global variable for this activity. Accept defaults. Click Apply and then OK.

f. Click OK to close the Invoke window. Ensure your invoke window looks like this.
3.4 Changing the Inbound Message Type

Now we change the BPEL process inbound Message Type to match the Partner Link requesting message.

1. Save your work and refresh the schemas just loaded from the WSDL using the “refresh” button. See the cursor below. This is on your bottom left window.

2. In the Structure pane (bottom left pane in JDeveloper window), scroll down to find Message Type. Expand Message Type ➤ Process WSDL to see PersDataRequestMessage. Highlight it and right click. In the popup menu, click on Edit Message Type.

   Note: If the Structure window does not appear, select Structure from the View Menu. If that doesn’t work, click your mouse to a Partner Link swim lane to refresh the JDeveloper windows.
3. In the **Edit Message Type** popup window, highlight the current **Message Part** and click on the **Edit** button.

![Edit Message Type - PersDataRequestMessage](image)

4. In the **Edit Message Part** popup window, click on the **flashlight** icon for the Element line.

![Edit Message Part - payload](image)
5. In the **Type Chooser** popup window, expand **Partner Links → CI_CI_PERSONAL_DATA.1 → CI_CI_PERSONAL_DATA.1.wsdl → Inline Schemas → xsd:schema**

Select **Get_ComplIntfc_CI_PERSONAL_DATA** and click **OK**.

![Type Chooser](image)

*Note: The response time will depend on your network connection as the WSDL definition is retrieved from the PeopleSoft server.*

6. Click **OK** and **OK** on all the windows to close them.
3.5 Changing the Outbound Message Type

Now we repeat the steps above for outbound message type.

7. In the Structure pane (bottom left pane in JDeveloper window), expand Message Type -> Process WSDL to see PersDataResponseMessage. Highlight it and right click. In the popup menu, click on Edit Message Type.

*Note: If the Structure window does not appear, select Structure from the View Menu. If that doesn’t work, click your mouse to a Partner Link swim lane to refresh the JDeveloper windows.*

8. In the Edit Message Type popup window, highlight the current Message Part and click on the Edit button.

9. In the Edit Message Part popup window, click on the flashlight icon for the Element line.
10. In the **Type Chooser** popup window, expand **Partner Links** → **CI_CI_PERSONAL_DATA.1** → **CI_CI_PERSONAL_DATA.1.wsdI** → **Inline Schemas** → **xsd:schema**

Select **Get_CompIntfc_CI_PERSONAL_DATAResponse** and click **OK**.

Click **OK** and **OK** on the windows to close them.
Save your work (File → Save All).

3.6 Creating an Assign to Copy Request Data to the PeopleSoft Web Service

1. Drag and drop an Assign activity from the Component Palette section between the receiveInput and Invoke_PersDataCl activities so we can copy the input to the Invoke input variable.

2. Double-click the Assign icon that you just dropped to display the Assign window.

3. Click the General tab

4. Enter CopyInput in the Name field

5. Click Apply

6. Click the Copy Operation tab

7. Click Create and then Copy Operation from the drop down
8. Define your Copy Rule to match the following

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>InputVariable → payload</td>
<td>Invoke_PersDataCI_CI_CI_PERSONAL_DATA_G_InputVariable → parameter</td>
</tr>
</tbody>
</table>

9. Click **OK** to close the Create Copy Rule window and **OK** again for the Assign window.
3.7 Creating an Assign to Copy Response Data from the PeopleSoft Web Service

10. Drag and drop an **Assign** activity from the Component Palette section between **Invoke_PersDataCI** and replyOutput activities so we can copy the CI response to output variable.

11. Double-click the **Assign** icon that you just dropped to display the Assign window.

12. Click the **General** tab

13. Enter **CopyOutput** in the **Name** field

14. Click **Apply**

15. Click the **Copy Operation** tab

16. Click **Create** and then **Copy Operation** from the drop down
17. Define your Copy Rule to match the following

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Invoke_PersDataCl_CL_CI_PERSONAL_DATA_G_OutputVariable</code></td>
<td><code>OutputVariable → payload</code></td>
</tr>
</tbody>
</table>

Click **OK** to close the Create Copy Rule window and **OK** again for the Assign window. Your BPEL process is complete.
3.8 Validating, Compiling and Deploying the BPEL Process

1. Your BPEL process should look like the following

2. Click the **Save All** button to save the BPEL project

3. Go to the **Applications Navigator** section

4. Right-click the **PersData** BPEL Project

5. Select **Deploy → OOW2008 → Deploy to default domain**
This will compile and deploy the BPEL process to your local Application Server (the process takes about 10-20 seconds).

[deployDecisionServices] There are no decision services to deploy

BUILD SUCCESSFUL
Total time: 15 seconds
# 4 Testing the Integration Solution

## 4.1 Invoking the Component Interface Service from BPEL

You can test your BPEL project by initiating the BPEL process from the BPEL Console.

Log into the Oracle BPEL Console using Internet Explorer by clicking on the URL on your desktop.

1. The default Username is **oc4jadmin** and the default password is **welcome1**

2. Click on the **PersData** process in the Deployed BPEL Processes list.
3. This takes you to the Initiate tab of the PersData BPEL Process where you will see an HTML form to initiate a test instance. We will use the XML Source radio button. Click the XML Source radio button, which creates a text area to enter an XML message.

Enter the following SOAP message in the text area. You can copy the contents from the PersData.txt file located in your desktop folder FMW4Apps → LabFiles → PSFT

```
<soap:Envelope xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/"
<soap:Body xmlns:ns1="http://abc-consulting.com/M1053122.V1"
  <ns1:Get__CompIntfc__CI_PERSONAL_DATA>
    <ns1:KEYPROP_EMLID>0043</ns1:KEYPROP_EMLID>
  </ns1:Get__CompIntfc__CI_PERSONAL_DATA>
</soap:Body>
</soap:Envelope>
```

The **EMPLID** is where you plug in PeopleSoft Employee ID. The above 0043 is an example you can use.
4. Click on the **Post XML Message** button.

**Initiating a test instance**

To create a new 'test' instance of this BPEL Process, fill the following text and click on the 'Post XML Message' button.

```xml
<soap:Envelope xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/">
  <soap:Body xmlns:nsl="http://abc-consulting.com/M1053122.V1">
    <nsl:Get_CompIntfc_CI_PERSONAL_DATA>
      <nsl:KEYPROP_EMPLID>0043</nsl:KEYPROP_EMPLID>
    </nsl:Get_CompIntfc_CI_PERSONAL_DATA>
  </soap:Body>
</soap:Envelope>
```

*Note: XML source view contents will not be reflected in the HTML form view*

- [ ] Save Test
- [ ] Perform stress test

5. The follow page will return with Personnel Details for employee # 0043.
Your test request was processed synchronously. It took 8.797 seconds to finish and generated the following response:

```xml
<Get_CompIntfc_CI_PERSONAL_DATAResponse http://xmlns.oracle.com/EnterpriseTools/schemas/M488347.V1>
  <PROP_EMLID>http://xmlns.oracle.com/EnterpriseTools/schemas/M488347.V1>
  <PROP_BIRTHCOUNTRY>USA</PROP_BIRTHCOUNTRY>
  <PROP_DERIVED_EMP>N</PROP_DERIVED_EMP>
  <PROP_DERIVED_CWR>N</PROP_DERIVED_CWR>
  <PROP_DERIVED_P01>N</PROP_DERIVED_P01>
  <PROP_WAIVE_DATA_PROTECT>N</PROP_WAIVE_DATA_PROTECT>
  <PROP_CAN_ABORIGINAL>N</PROP_CAN_ABORIGINAL>
  <PROP_CAN_VISSDL_MINORITY>N</PROP_CAN_VISSDL_MINORITY>
  <COLL_NAME TYPE=VW>
    <KEYPROP_NAME TYPE>PRI</KEYPROP_NAME TYPE>
    <COLL_NAMES>
      <KEYPROP_NAME TYPE>PRI</KEYPROP_NAME TYPE>
      <KEYPROP_EFFDT>2007-01-17</KEYPROP_EFFDT>
      <PROP_COUNTRY_IN_FORMAT>001</PROP_COUNTRY_IN_FORMAT>
      <PROP_NAME_PREFIX>M</PROP_NAME_PREFIX>
      <PROP_LAST_NAME>Mary</PROP_LAST_NAME>
      <PROP_FIRST_NAME>John</PROP_FIRST_NAME>
      <PROP_LAST_NAME_PREF_HLD>Y</PROP_LAST_NAME_PREF_HLD>
    </COLL_NAMES>
  </COLL_NAME TYPE>VW>
</Get_CompIntfc_CI_PERSONAL_DATAResponse>
```

Success.
5 Advanced Credit

5.1 BPEL Console

Go back to BPEL Dashboard and look at completed process instances.

Check the executed flow diagram of completed instances. Click on each step in the process to see the XML data flowing through the step.

5.2 JDeveloper

Explore the different activities you can use in a BPEL process.

Look at Process Activities and you will find an array of nodes to use. Of particular interest are:

1. Human Task flow, which can be used to include human approval steps and assign tasks to people.
2. Transform node, which is used to create XSLT transformations. It brings up a graphical mapper, from which you can drag and drop.

5.3 Log into PeopleSoft and lookup up PERSON_DATA CI

The goal here is to see how the WSDL is generated in PeopleSoft, and see the definitions for the PERSON_DATA CI.

1. Go to http://hr848.us.oracle.com:7777/psp/ps/?cmd=login. There is a shortcut in your deskstop folder FMW4Apps → Shortcuts. For login use UID / PWD = PS / PS


3. Enter %CL_PERS% as shown below. You will see a list of CI. Choose CI_PERSONAL_DATA. Hit the Search button at bottom.
4. Select the checkbox next to **CI_PERSONAL_DATA** and click on the **Review CI Status** button.

Click on **View Service Definition**. This screen shows general service information, including its operations and messages.
The Provide Web Service link allows you to generate the WSDL URL (which is what we used in BPEL Partnerlink).

We will not be running the wizard here as accidental changes could alter the configuration and prevent others from completing the lab.

At your leisure, you can go to PeopleSoft and FMW Best Practice Center on Oracle Technology Network and check out the hands-on tutorials. There-in you will find BPEL tutorials (and more) with detailed steps on PeopleSoft end of the configuration.